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About the Manuals Us

Included with the Reader is the Quick Start Guide and this
PDF-format User’s Guide. Additionally, after installing eBook
Library software from the supplied CD-ROM, you can refer
to the Help within eBook Library.

Browsing the User’s Guide

This PDF-format User's Guide can be browsed on both your
computer and the Reader.

Browsing this Guide on your computer

Click the Start menu in the bottom left of the Desktop, then
select “All Programs” — “Reader” — “PRS-505 User’'s Guide”
to start Adobe Reader and open the User’s Guide.

For details on how to use Adobe Reader, refer to Adobe
Reader Help.

Hint

* To view the User’s Guide, you should have installed Adobe Reader
5.0 or later. Adobe Reader can be downloaded for free from the
Adobe website (www.adobe.com).
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Browsing this Guide using the Reader

From the Home menu, select “Books by Title” — “User’s
Guide” from the Book list. The User’'s Guide can be opened
by selecting “Option Menu” — “Begin.”

| PDF Link
1S

Q@ (size) button

‘® 6

Hints

* A [>] mark on this Guide indicates a link. Using the </V/A/»/Enter
buttons, press A/V to select the desired link, then press Enter to
jump to the linked page.

* To zoom in a page, press @ (size).

For details on how to open books or PDF files, refer to 5] page
35, 39.

Using the eBook Library Help

Refer to the eBook Library Help for details about using
eBook Library, such as importing books to your computer
and transferring them to the Reader.

Follow the steps below to start eBook Library and browse
Help.

© Click the Start menu from your computer, then
select “All Programs” — “Reader” — “eBook Library.”

e Click “Help” — “eBook Library Help” on the Menu bar.
Help appears.
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Introduction

What You Can Do with Reader

First, read the Quick Start Guide to prepare the Reader for
use. Initially after purchase, you need to charge the Reader
battery and install the dedicated software “eBook Library” on
your computer.

Once initial preparation is complete, you can transfer
content from your computer to the Reader to take anywhere
you wish.

Downloaded
1 eBooks

*T CONNECT eBooks (online e-Book store)
*2 Book/Audio/Picture files that you already have

(Gettlng Started) Charge the Reader, then install eBook Library
on your computer.

(roming) » (romsiieg) » (o)

Playing/Viewin
Download eBooks from Transfer content from your ying/V 9
CONNECT eBooks on your computer to the Reader Enjoy content on the
computer. using eBook Library. Reader.
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Guide to Parts and Controls
@ [ 7] 6]

%} S =t Do (A 1 D))" }

Front

[1] Enter button*
To decide an item or apply a setting, ~
press the Enter button. @I Enter button
2] </A/Y/> buttons*' )
To select an item or scroll around the screen, press «
(left), A (up), ¥ (down), or p (right).
** In this manual, the operation of the </A/¥/»/Enter buttons are
explained as follows.

(Example) Press 4/A/V¥/» to select “Away” on the Book list, then
press Enter.

Continued 8%



MENU button
To return to the previous screen or show a menu. (>
page 13)
[4] M (page) / (>/<) buttons
To turn the page or proceed/return to the next (>)/
previous (<) content. (] page 36, 38, 53, 56)
Number (1 — 9,0) buttons
To select the numbered items on the screen or input
numeric values on the Setting menu. (5] page 36, 38, 51,
55)
(6] SD Memory Card slot
To insert a SD Memory Card (optional). (] page 20)

“Memory Stick Duo” slot
To insert a “Memory Stick Duo” (optional). (=] page 20)

POWER switch
To switch on/off the Reader. (>] page 15)

[9] Indicator
Lights up in red while charging, and goes off when
charging is complete. (5] page 17)
Flashes in orange while the Reader is accessing your
computer via USB.
Also flashes in orange while switching the Reader on or
off.

Continued 9



Holes for soft cover attachment
The soft cover is attached when purchased. (5] page 12)
Folds open in use

_—

* Do not leave the Reader in a high temperature conditions, as it
may damage the soft cover.

@ (size) button
To zoom in/out a page or picture. (>] page 39, 56)

M (MARK) button
To create/remove a bookmark. (] page 47)

Hole for hand strap
To attach the hand strap.

USB connector
To connect the USB cable (supplied). (=] page 28)

DC IN jack
To connect the AC power adapter (optional).

Hint
* The Reader can be charged by connecting to a computer
using the supplied USB cable.

Continued 10



) (Headphones) jack
To connect headphones (optional). (5] page 51)

VOLUME +/- buttons
To adjust the volume. (=] page 53)
To mute the sound, press and hold the VOLUME +/—
buttons. To restore the sound, press the VOLUME +/—
buttons again.

Rear

@]®
= = 0=

(18]

Reset button
To reset the Reader if no operation is possible. (=] page
68)

Continued 11



About the serial number

The serial number provided for the Reader is required for
the customer registration. The number is on the label on the
rear of the Reader. Do not remove the label.

Removing/attaching the soft cover
== [B]

Removing the soft cover
(@ Pull the tab of soft cover towards [A].
@ Remove the Reader in the direction of [B].

Attaching the soft cover

@ Insert the tab [C] of the soft cover in the hole [D] of the
Reader.

@ Pull the tab of the soft cover towards [A].

® Insert the Reader in the direction of [E] to attach it to the
soft cover.

(@ Check that the tabs of the soft cover are completely
inserted in the holes of the Reader.

* Note that the tab of the soft cover may become deformed, if you
pull the tab too strongly.
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Basic Operations

Menu Operations

You can switch between screens, read/play/view content, or
set items, using the €/A/V¥/»/Enter buttons, number buttons,
or MENU.

Example: screen transition diagram of the Home menu —
Book list — Option menu — Book page

Number tab
Selected item is highlighted in black.

Continue Reading .
[ Books by Title o
& Books by Author
Books by Date
Wil Collections

[T All Bookmarks

Press A/V to select “Books by Title” then press
Enter.

11 Now Playing
73 Audio
[ Pictures

‘Amesomets in Mathematice
£ Settings |
=D

R A Christmas Carol

[ER) Dream Psychology
£R Emma
R Les Miserables

[ER Metamorphosis o
{8 Moby Dick, or, the wha[e
£8 A Study in Scarlet _ i )
ER The Time Machinf; e ‘ )
ER Ulysses

ool N[0 lulslc W=

Press A/V to select,
then press Enter.

£3 A Christmas Carol
Continue Reading

Begi
EBegn .

o
o
End rois
[ Bookmarks I
PreSS M EN U tO —K Table of Contents

return to the DMy

@ Info

previous screen. © Utities

.....

Press A/V to
select, then
press Enter.
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Hints

* By pressing and holding @ (size), screen orientation can be
switched (vertically/horizontally). ([>] page 41)

* By using the number buttons, corresponding numbered items can
be selected.

* By pressing and holding MENU, the screen can be returned to the
Home menu.
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Turning on Reader

Slide the POWER switch in the direction of » to turn on the
Reader.

Slide the POWER
switch.

The Reader turns on.

It may take a few moments to turn on the Reader and the
start-up screen to appear when used for the first time, after
a reset or shut down, or when the battery has depleted.
The indicator lights up in orange when the Reader is turned
on.

To turn off the Reader

Slide the POWER switch in the direction of » again.
The Reader turns off.
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About the Sleep Mode (resume function)

You can set the Reader to automatically enter sleep mode.
In sleep mode, the Reader automatically turns off if no
operation is performed for 60 minutes (resume function).
The previously displayed screen appears when turned on by
sliding the POWER switch from this state.

The Sleep Mode setting can be configured from the Setting

menu (>] page 61).

* In the following states, the Reader will not automatically turn off,
even if no operation is performed for 60 minutes.
— When connected to the computer using the supplied USB cable
— When connected to the AC Adaptor for Reader (AC-S5220E)
(optional) to charge
— When playing audio files
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About charging
Charging the Reader is required when using for the first
time. Turn on the Reader, and then charge in one of the

following two ways.

e Connect to a computer via USB (Refer to the Quick Start Guide
and [>] page 27).
(Charging time: approx. 4 hours™)

* Connect to an AC outlet using the AC power adapter and AC
power cord (optional).
(Charging time: approx. 2 hours*)
* Approximate time required to fully charge the battery.

* When you connect the Reader to your computer, (indicating
connection via USB) is displayed on the Reader’s screen. If the
battery has been fully depleted, it takes about 40 minutes until
is displayed, and you will not be able to turn on the Reader by the
POWER switch during this time. In this case, wait until is
displayed. The indicator lights up in red while is not displayed,
and the Reader is charged.

* |If the remaining battery power of a connected notebook computer
is low, charging via USB connection may not be possible.

¢ If you connect the Reader to a notebook computer which is not
connected to an AC outlet, the battery of the notebook computer
will be consumed. Do not leave the Reader connected to a
notebook computer which is not connected to an AC outlet for an
extended period.

* Connecting the Reader via a USB hub or extension cable may not
work and is not supported. Connect the USB cable directly to the
computer.

Continued 17



You can verify the remaining battery power by checking the
indicator in the bottom left of the screen. Charge the battery
when remaining power is low (the fewer black segments
indicated, the lower the remaining power).

(CLLL g CTTW) g (T g o g o g

¢ If the remaining battery power is low, the following warning
appears. Charge the battery.

If you continue to use without charging, the following warning
appears, and the Reader will turn off automatically.
Charge the Reader and turn it on again.
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Inserting a Memory Card

The following memory cards can be inserted in the Media
slots of the Reader.

* The Reader has separate slots for “Memory Stick Duo” and the SD
Memory Card. Be sure to insert the memory card in the correct
slot. Inserting the memory card in the wrong slot may damage the
slot and the memory card.

“Memory Stick Duo”" “Memory Stick Duo”
“Memory Stick PRO Duo”
SD Memory Card™ SD Memory Card
miniSD Card "

*! The Reader does not comply with MagicGate standard, and the data
requiring the copyright protection function cannot be copied or played
on the Reader.

*2 The Reader does not comply with copyright protection of SD Memory
Cards.

*3 miniSD Card adaptor (sold separately) required.

* An operation check is performed when using a “Memory Stick Duo”
of up to 8 GB, however, operation of all “Memory Stick Duo” is not
guaranteed.

* An operation check is performed when using an SD Memory Card
of up to 2 GB, however, operation of all SD Memory Cards is not
guaranteed.

* When inserting the memory card into the Reader, it may take time
for the Reader to recognize the content files in the memory card if
the capacity of the content files stored on the memory card is large.
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Inserting a memory card into the Reader

o Remove dummy cards from the “Memory Stick Duo”
slot and SD Memory Card slot.
The dummy cards are inserted in the “Memory Stick
Duo” slot and the SD Memory Card slot at purchase.
When not using the memory card, insert the dummy
card into the slot.

e |f the dummy card is not inserted in the slot, foreign objects may
enter the slot, and cause malfunction or damage.

Continued 20



9 Insert a memory card in the » direction with its label
side up until it clicks into the place.

* The Reader has separate slots for “Memory Stick Duo” and the
SD Memory Card. Be sure to insert the memory card in the
correct slot. Inserting the memory card in the wrong slot may
damage the slot and the memory card.

( 1\

“Memory  SD Memory
Stick Duo” Card

>
Mark 1. Mark

* Be sure to insert the memory card in the correct direction. Forced
insertion may damage the slot.

¢ Do not insert an incompatible memory card, as it may cause
malfunction.

* Do not use a deformed memory card or adaptor.
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Removing a memory card from the Reader

o Gently push in the memory card.
You will hear a click, and the memory card pops out.

( )

“Memory SD Memory
Stick Duo” Card

9 Remove the memory card squarely from the
“Memory Stick Duo” slot or the SD Memory Card
slot.

* Do not remove a memory card or turn off the Reader while reading
or writing data, as data may be damaged.
* For details on handling memory cards, refer to [>] page 86.
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Importing Content

Importing eBooks from CONNECT
eBooks

You can download eBooks from the online e-Book store
“CONNECT eBooks” to your computer.

Use the dedicated software eBook Library to access
CONNECT eBooks.

* To download eBooks, you need to prepare an Internet-accessible
environment on your computer.

* You need to authorize your computer to CONNECT eBooks to
download eBooks.
You also need to authorize the Reader to CONNECT eBooks to
transfer and read downloaded eBooks on the Reader.
For details, refer to the eBook Library Help.

o Double-click the eBook Library icon () on
Windows desktop.

Hint
* You can also start eBook Library by clicking the Start menu and
then selecting “All Programs” — “Reader” — “eBook Library.”

9 Click “eBook Store” in the Source view.

The View area is switched to the Store view and
CONNECT eBooks appears.
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9 Follow the page instructions to purchase
(download).
Downloaded eBooks are automatically imported to
“Library” in the Source view.

Library —¢ =5 Downloaded
content
@ =
.
Source view
Hint
* Purchased eBooks are grouped under “Purchased” in the
collection.
Hints

* eBooks can be read on eBook Library using your computer. For
details on eBook Library operations, refer to the eBook Library

Help.
* The Source view appearance may vary depending on your
computer.
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Importing Content from Your
Computer

You can import content files stored on your computer into
Library of eBook Library.

You can import the following content files.
* Book
PDF file, Text file, RTF file, Word file*, BBeB Book
* Audio
Un-encrypted MP3 and AAC format audio files
— MP3 file (.mp3 file extension)
The following specifications should be met in order to import an
MP3 file.
Bit rate: 32 to 320 kbps
Sampling frequency: 22.05, 44.1 kHz
— AAC file ( .mp4, .m4a, .mov, or .qt file extension)
The following specifications should be met in order to import an
AAC file.
Bit rate: 40 to 320 kbps
Sampling frequency: 24.0, 44.1, 48.0 kHz
* Picture
Bitmap file, JPEG file, GIF file, PNG file

*Word files will be automatically converted into RTF files during
transfer only if Microsoft Word is installed on your computer.

For details on content files you can import, refer to the
eBook Library Help.
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Importing content files

You can select content files stored on your computer and
import them into Library.

o Click the Start menu, then select “All Programs” -
“Reader” — “eBook Library” to start eBook Library.

9 Click “Import Files” on the “File” menu.
The “Import Files” dialog box appears.

@ cClick -] of the “Look in” list to select the folder
containing the content file(s) to be imported, as
necessary.

The content files in the selected folder are listed.

Hint
* You can also double-click the folder (in the folder list) to display
the content files in the folder.

O select the content file to be imported.

To select multiple files, click the files while holding down
the Ctrl key.

e Click “Open.”
The content file(s) is imported into Library.

Hint
* You can import all the content files in a selected folder at the same
time into Library from “Import Folder” on the “File” menu.
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Transferring Content

Transferring Content to Reader
Connected with Your Computer

You can transfer (copy) the content in the Library to the
Reader.

If the Reader is locked, it will not be recognized on your computer
and content cannot be transferred. (=] page 63) If you connect the
Reader to your computer, disconnect it and unlock the Reader by
inputting the password.

Hints

The book content can be grouped in the Library as a collection,
which can be transferred to the Reader. For details on how to
create or transfer a collection, refer to the eBook Library Help.
You can synchronize content in Library of eBook Library with the
Reader by specifying a folder (such as “Library” or the sub-items
under “Library”). (=] page 34) The Reader can be automatically
updated to match the content in Library, when you connect it to
your computer.

o Click the Start menu, then select “All Programs” -

“Reader” — “eBook Library” to start eBook Library.

Continued 27



9 Connect the Reader to your computer using the
supplied USB cable.

To USB connector

USB cable
(supplied)

“Sony’s Reader” appears in the Source view of eBook
Library.

A screen appears on the Reader, indicating that it is
connected to the computer.

e If “Sony’s Reader” does not appear in the source view after
connecting the Reader to your computer, disconnect the USB
cable from the Reader, then reconnect it after a while.

* When you connect the Reader to your computer,
(indicating connection via USB) is displayed on the Reader’s
screen. If the battery has been fully depleted, it takes about 40
minutes until is displayed, and you will not be able to turn
on the Reader by the POWER switch during this time. In this
case, wait until is displayed. The indicator lights up in red
while is not displayed, and the Reader is charged.

Continued 28



9 Click “Library” in the Source view, then click = (List
view).

The View area is switched to the List view and all the
content in the Library is listed.
Hints

e When you click “Books,” “Audio” or “Pictures” in the Source view,
only their respective content is displayed.

e When you click & (Thumbnail view), content can be displayed as
thumbnails.

* You can create a collection in the Library and the collection can
be transferred to the Reader. For details on how to create or
transfer a collection, refer to the eBook Library Help.

O Select the content you want to transfer from the list.

To select multiple content, click the content while
holding down the Ctrl key.

(5) Drag the content from the list to “Sony’s Reader” in
the Source view.

The content is transferred to the Reader.

I

Sony’s Reader
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Hint

* You can store computer data into the built-in flash memory of the
Reader by transferring the data from your computer using Windows
Explorer.

e If there is not enough free space on the memory of the Reader,
content may not be transferable. Transfer any unnecessary content
back to eBook Library, then delete it to increase free space on the
Reader. (>] page 32)

* Do not delete files in the folder under “database,” and files in
“database,” using Windows Explorer. Perform data management
using eBook Library. For details on the eBook Library operations,
refer to the eBook Library Help.

Transferring content via a memory card

Content imported to eBook Library can be transferred to a
memory card on the Reader.

Hint
* “Memory Stick Duo” and SD Memory Card can be used.

o Click the Start menu, then select “All Programs” —
“Reader” — “eBook Library” to start eBook Library.

9 Connect the Reader to your computer using the
supplied USB cable. (>] page 28)
“Sony’s Reader” appears in the Source view of eBook
Library.
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9 Insert a memory card into the Media slot of the
Reader. (>] page 20)
“Memory Stick/SD Card on Sony’s Reader” appears in
the Source view.

O Click “Library” in the Source view of eBook Library,
then click = (List view).

The View area is switched to the List view and all the
content in Library is listed.

Hints

* When you click “Books,” “Audio” or “Pictures” in the Source view,
only their respective content is displayed.

« When you click ® (Thumbnail view), contents can be displayed as
thumbnails.

* You can create a collection in Library and the collection can be
transferred to a memory card on the Reader. For details on how to
create or transfer a collection, refer to the eBook Library Help.

9 Select the content you want to transfer from the list.

To select multiple content, click the content while
holding down the Ctrl key.

@ Drag the content from the list to “Memory Stick/SD
Card on Sony’s Reader” in the Source view.

The content is transferred to the memory card on the
Reader.
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Hint

* You can store computer data into the memory card on the Reader
by transferring the data from your computer using Windows
Explorer.

* If there is not enough free space on the memory card, content may
not be transferable. Transfer any unnecessary content back to
eBook Library, then delete it to increase free space on the memory
card. (>] page 32)

* Do not delete files in the folder under “Sony Reader,” and files in
“Sony Reader,” using Windows Explorer. Perform data
management on eBook Library. For details on eBook Library
operations, refer to the eBook Library Help.

To transfer content back to eBook Library

o Click the Start menu, then select “All Programs” -
“Reader” - “eBook Library” to start eBook Library.

9 Connect the Reader to your computer using the
supplied USB cable. (>] page 28)
“Sony’s Reader” appears in the Source view.
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Click “Sony’s Reader” in the Source view, then click
= (List view).

The View area is switched to the List view and all the
content in Library is listed.

Hints

* When you click “Books,” “Audio” or “Pictures” in the Source view,
only their respective content is displayed.

» When you click & (Thumbnail view), contents can be displayed as
thumbnails.

* You can create a collection in the Reader and a memory card on
the Reader, and the collection can be transferred to eBook
Library. For details on how to create or transfer a collection, refer
to the eBook Library Help.

Select the content you want to transfer back from
the list.

To select multiple content, click the content while
holding down the Ctrl key.

15/

Drag the content from the list to “Library” in the
Source view.

The content is transferred back to eBook Library.
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Synchronizing content in Library with Reader

You can synchronize content in the Library of eBook Library
with the Reader by specifying a folder (such as “Library” or
the sub-items under “Library”). The Reader can be
automatically updated to match the content in the Library,
when you connect it to your computer.

* To synchronize content in the Library of eBook Library with the
Reader, you need to specify a folder (such as “Library” or the sub-
items under “Library”). For details on how to specify a folder, refer
to the eBook Library Help.

Hint

* When you want to synchronize content in the Library with the
Reader right away, you can also synchronize them manually. For
details on how to synchronize content manually, refer to the eBook
Library Help.

o Click the Start menu, then select “All Programs” -
“Reader” — “eBook Library” to start eBook Library.

9 Connect the Reader to your computer using the
supplied USB cable. (>] page 28)
eBook Library starts synchronizing content in the
Library with the Reader automatically.

Hint

* If you start eBook Library after connecting the Reader to your
computer, eBook Library also starts synchronizing content in
Library with the Reader automatically.
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Reading/Playing/Viewing Content

Reading Books

Reading books transferred from your computer

Follow the steps below to read books transferred from your
computer.

o In the Home menu, press A/V to select “Books by
Title,” then press Enter.
The Book list appears.
If the contents of the book on the Reader and the
memory card exceed 30 items, the Index menu appears.
The Book list can be further sorted by selecting the
category item in the Index menu. (] page 43)

Indicates that

oo
oo Coninue Reading . R vament m wanemt @ stored on a
- e ou
[ Books by Title K (2 A Christmas Carol 2 m em 0 ry Ca rd .
& Books by Author 3| Dream Psychology ; @ “ M emo ry
oo [ sarmncrions | [ .
Books by Date . Emma 4 Sthk D uo”
N} Collections a8 » Les Miserables 5 - .
[13 All Bookmarks ) E Metamorphosis - g " S D Me m 0 ry
11 Now Playing . ; Moby Dick, or, the whale . ; Card
J3 Audio o ; A Study in Scarlgrt' ;
[ Pictures lol The Time Machine lol N um bel’ tabS
scicree | '\ [
(=1 Settings _ o Ulysses le
—rT— A=
@ indicator
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Hints

* The content on the memory card also appears in the Book list.

* In addition to A/¥, you can also select an item by pressing the
same number button as indicated on the number tab.

* To display the rest of the list, press > (repeatedly).

* You can jump directly to the last displayed page by selecting
“Continue Reading” from the Home menu, without displaying the
Book list.

* If an invalid operation is performed, & appears at the bottom of
the screen.

Press A/V to select the desired book from the list,
then press Enter.

The Option menu appears. (=] page 37)

Press A/V to select how to open the book, then
press Enter.

To read the book from the beginning, press A/¥ to
select “Begin,” then press Enter.

The first page of the book appears.

To open the book’s table of contents or the bookmarks
of the PDF file, press A/Y to select “Table of Contents,”
then press Enter.

The table of contents/bookmarks appears (if contained
in the book/PDF file).

Press MENU to close the book.
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About the Option menu

The hook tit

Continue Reading

P

le is displayed.

E.IM,_ To open the last displayed page.

[ Begin
End

To open the first page of the book.

Page 25

Elﬂ Bookmarks

<

' To open the final page of the book.

Table of Contents o
@ History
@ Info

& Utilties

yyyyyyy

gggggg

=1 10f1

IG5

;L To open the Bookmark list. (>] page 47)

L To open the table of contents of the
book or the bookmarks of the PDF file,
if contained in the book/PDF file.

To open the list of previously displayed
pages (=] page 50)

Book types

— To display the book information. (=] page 42)

— To remove all bookmarks or clear history.
(=] page 49, 50)

supported by the Reader

The following are the book types supported by the Reader
and their characteristics.

eBook A book in BBeB format that you can

(.Irf and .Irx file download from CONNECT eBooks.

extension) The link tool embedded in eBooks (page
jumps, etc.) can be used. (5] page 39)

PDF file A File in PDF format (Version 1.4 or before)

(.pdf file Bookmark and link tool on PDF files can

extension) be used.

Text file

(.txt file extensi

on)
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RTF file

An RTF file that is automatically converted

(rtf. file extension) |from a Microsoft Word file.*

* Only if Microsoft Word is installed on your
computer.

Operations on the Book page screen
On the Book page screen, the following operations can be

performed.

Size indicator

— Current page number/

ommcomm  t0tal page number

Button Operation
> button To proceed to the next page (press);
jump 10 pages ahead of the current page
(press and hold).
< button To return to the previous page (press);
jump 10 pages back from the current page
(press and hold).
Number To jump to the selected page (press) (=] page
buttons 40);

Jump to the final page (press and hold 0); jump
to the first page (press and hold 1); jump to any
other page corresponding to the button
number(s) (press and hold 2 -9).
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Button

Operation

Q (size)

button

To zoom in/out a page.

Every time you press @ (size), the page is

magnified in steps and returns to the original

scale after the maximum magnification.

* When reading an eBook or Text file:
The scale switches in 3 steps (€), @, @ - indicated
at the bottom of the screen).

* When reading a PDF file:
The scale switches between “Fit width” (page fits
the width of window) and “Fit Visible” (texts and
graphics fit the width of window).

* By pressing and holding @ (size) for a few
seconds, screen orientation can be switched
(vertically/horizontally). (=] page 41)

(MARK)
button

To create/remove a bookmark on the current

page (press) (=] page 47, 49);
Jump to the All Bookmark screen (press and hold).

MENU button

To close the page and return to the Option menu.

To use the link tool of eBooks/PDF files on the

Reader

When an eBook or a PDF file is displayed, you can use the
embedded link tool.

The link appears highlighted on the screen. Press Enter to
open the linked content or jump to the linked page.

Chapter 3 - The Secont

Chapter 2 - The First of the Three Spirits

Chapter 4 - The Last of the

Link

Press A/V to select the desired link,
and press <€/ to return to the
L previously displayed page.

he Three Spirits

Spirit
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Jumping to the specified number page
directly

You can jump directly to a page by inputting the page
number with the number buttons.

© On the Book page screen, press the number buttons
to input the page number.
The input page number appears in the center of the
page.

To clear the input page number, press «.

9 Press Enter.
The page of the input page number appears.
Hint

* By pressing MENU, the previous screen appears. You can input
the page number again.
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Switching screen orientation (vertical/

horizontal)

Screen orientation (including menu screens) can be

switched in the following 2 ways.

* Press and hold @ (size) on a menu screen or a Book page screen.
Press and hold @ (size) again to switch back.

* Configure the setting from the Setting menu. (=] page 58)

About screen division when screen orientation
is set to horizontal
When set to horizontal, the Book page is divided into 2 parts
(upper and lower). To display the lower part, press >.
Displaying Displaying
upper half lower half

Position
indicator
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Displaying the book information

You can display the book information, such as the title,
author, book cover thumbnail, etc.

o In the Option menu, press A/V to select “Info,” then
press Enter.

The book information appears.
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Sorting the Book list

On the Book list of “Books by Title”, books are sorted by title
alphabetically. You can also sort books by author or date.

If the contents of the book on the Reader and the memory
card exceed 30 items, the Index menu appears. The Book
list can be further sorted by selecting the category item in
the Index menu.

o In the Home menu, press A/V to select “Books by
Title,” “Books by Author” or “Books by Date,’ then
press Enter.

The Index menu appears. (>] page 45)

The Index menu does not appear if the contents of the
book on the Reader and the memory card is less than
30 items. In this case, press < to display the Index

menu.

Continue Reading et i oo S q
[ Books by Title e (H EpABC . E
& Books by Author e 8 EDEF i 3]
Books by Date e |4 EGHI } |4
il Collections ot ; » EHIKL , g
[T All Bookmarks o lel HIMN O g
11 Now Playing T EPQRS 7
13 Audio s mTuv o
[ Pictures 7‘ ‘ ; EwWXYZ ;
= Settings '“ : ; {Hf Other ;
o —T—

=1 3

Hint
* If you select “Books by Date,” the category items of the Index
menu are different from above. (>] page 45)
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9 Press A/V to select how to sort the Book list, then
press Enter.

Hi1-B
BR 1192

o
[} 20th Century Ghosts (Excerpy)
[ER 300
Abelia spathulata

(R Acanthopanax divaricatus

oo [N[o[o[s[e[®[=

Amusements in Mathematics

R Away (Excerpt)

(R Berchemia racemosa
&

(57 Betula platyphylla var. japonic

5
R Bridge of Sighs (Excerpt)
i s

9 Press A/V to select the desired book from the list,
then press Enter.

The Option menu appears.

O Press A/VY to select how to open the book, then
press Enter.
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About the Index menu

Index menu of “Books by Title” Index menu of “Books by Date”
and “Books by Author”

The number of
o0 e
0-© 1 ““"""P’“’ju Ehuempl?grein the Tocey =)
M ABC ebere Pases E Book list Earlier This Week No bock E
MHDEF N 3 Last Week - E
(G H I . Earlier This Month e |14
Ml K L - Last Month |
HMN O I8 Earlier This Quarter —
mP QRS o Last Quarter .
HHTUV I8 Earlier This Year |
W x ¥ Z o ; Last Year _— g
Eglother _; Older g
E

Categories

When selecting “Books by Title” and “Books by
Author”’

You can select the first character of the book’s title or author. A Book
list sorted alphabetically by title or author, starting with the selected
characters, appears.

When selecting “Books by Date”
You can select the date that books are transferred to the Reader and
the memory card. A Book list sorted by transferred date appears.
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Selecting a book from the Collection list

You can select and read a book from the list of collections
created on eBook Library.

Hint
¢ For details on how to create or transfer a collection, refer to the
eBook Library Help.

o In the Home menu, press A/V to select “Collections,”
then press Enter.

The Collection list appears.

@ Press A/V to select the desired collection from the
list, then press Enter.

The Book list appears.

9 Select the desired book from the list, then press
Enter.
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Creating a bookmark on a page

You can create a bookmark on a page you may wish to
return to.

o On the Book page screen, press (13 (MARK) on the
desired page.

The mark appears in the top right corner of the page.
(&)—Bookmark

Chapter 2 - The First of the Three Spirits

If you press @ (MARK) again, the bookmark will be
removed.

Note

* When creating a bookmark, the Reader records the current page
and the current page scale. Therefore, even on the same page, if
the scale is switched and another bookmark created, the
bookmarks will be stored at their respective scales.
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To open the desired page from the Bookmark list

o In the Option menu, press A/V to select
“Bookmarks,’ then press Enter.

The Bookmark list appears.

9 Press A/Y to select the desired page, then press
Enter.

Hint

* Bookmarks can also be created in the eBook Library.
The bookmarks created on the Reader or eBook Library will be
retained when you transfer books between the Reader and eBook
Library.
If you transfer a book to eBook Library from the Reader, the
bookmarks created on the Reader will be also transferred to eBook
Library, and vice versa.
However, if you transfer a book to a location where the same book
exists, the bookmarks will not be overwritten.
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To remove all bookmarks in the current book

o In the Option menu, press A/V to select “Utilities,”
then press Enter.

9 Press A/V to select “Remove All Bookmarks,”’ then
press Enter.

All bookmarks in the current book are removed.

* Confirm carefully before removing bookmarks.

To select from the list of all bookmarks on the
Reader

o In the Home menu, press A/V to select “All
Bookmarks,” then press Enter.

The list of all bookmarks on the Reader appears.

9 Press A/V to select the desired page, then press
Enter.

Hint
* The All Bookmark list can also be displayed by pressing and
holding (M (MARK).
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Reading previously displayed pages

The Reader stores all displayed pages in memory for easy
recall at any time.

@ On the Book page screen, press <.

As you press « repeatedly, previously displayed pages
appear in reverse order.

To show the displayed page history

o In the Option menu, press A/VY to select “History,”
then press Enter.

The History list appears.

Hint
* The History list can store the histories up to 100 pages.

To clear History

o In the Option menu, press A/V to select “Utilities,”
then press Enter.

9 Press A/V to select “Clear History,” then press Enter.
History data of the current book is cleared.

 Confirm carefully before clearing History.
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Playing Audio Files

Playing audio files transferred from your

computer

Un-encrypted MP3 and AAC files can be played back on the
Reader.

You can also read books while listening to an audio file. (5]
page 53)

When listening to audio files, connect the optional
headphones to the headphone jack.

o In the Home menu, press A/V to select “Audio,’ then
press Enter.

The Audio list appears. ,
Indicates that

content is stored

ona memory
ETTTE— card
Continue Reading | sleepy Time - ﬂ @ “Memory
[ Books by Title L2 Valtz For Eddie 2 H ”
& Books by Author i ; _J . Sthk Duo
Books by Date w{ : ' SD Memory
[ilj Collections . ;W: ; » Card
(T8 All Bookmarks ”:;M ;‘ ;
11 Now Playing . ; _Number tabS
e -4 Thumbnails of
& Setings Tl pictures (if
T —T—— e —T— contained on files)
€ indicator
Hints

e The content on the memory card also appears in the Audio list.
¢ |n addition to A/V¥, you can also select an item by pressing the
same number button as indicated on the number tab.
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* To display the rest of the list, press > (repeatedly).

* If an invalid operation is performed, & appears at the bottom of
the screen.

e If an audio file is played, “Now Playing” can be selected on the
Home menu and the Playback screen can be displayed.

* The Now Playing icon in the Home menu changes when an audio
file is being played.

9 Press A/V to select the desired track from the list,
then press Enter.

Playback starts.
Tracks are played in alphabetical order.

To stop playback, press Enter.

Operations on the Playback screen
On the Playback screen, the following operations can be
performed.

Playback indicator

}

» Now Playing

e

Waltz

Track name ﬁ' For Eddie
Artist name — puu = Total time of the
Album name

El d nlavback . T N current track
tir%%se playbac ‘ T ©— Volume indicator

Status bar Current track
number/total
track number

-=— Picture area
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Button Operation

> button To skip to the next track.
< button To skip to the previous track.
<4/» To rewind/fast-forward the track.

Enter button | To stop/restart playing the track.

VOLUME +/- |To adjust the volume.
buttons

Reading books while playing an audio file

You can read books while listening to an audio file.

o In the Home menu, press A/V to select “Audio,’ then
press Enter.

The Audio list appears.

e Press A/V to select the desired track from the list,
then press Enter.

Playback starts.

9 Press MENU 2 times to return to the Home menu.

0 Press A/V to select “Books by Title,” then press Enter.
The Book list appears.

6 Press A/V to select the desired book from the list,
then press Enter.

The Option menu appears.
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@ Press A/Y to select how to open the book, then
press Enter.

The Book page screen appears.
While an audio file is played, the volume indicator

appears at the bottom of the screen.

Hint
* To stop playback, press MENU 3 times to return to the Home
menu, select “Now Playing” using A/Y and Enter, then press Enter

on the Playback screen.
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Viewing Pictures

Viewing pictures transferred from your computer
BMP/JPEG/GIF/PNG files can be viewed on the Reader.

o In the Home menu, press A/V to select “Pictures,’
then press Enter.
The Picture list appears.

Indicates that
content is stored

on a memory

card.

(R Continue Reading o oo .

[ Books by Title - E 00000 12006 ﬂ @ Me m 0 ry 2]
& Books by Author g oam00s J StICk D u 0
5] Books by Date 4 ol SD Memory
[ilj Collections E » Card

[Ty All Bookmarks 6

11 Now Playing 1 B Number tabs

J3 Audio 8|

B Pictures . Thumbnails

= Settings .. |9

& indicator

Hints

* The content on the memory card also appears in the Picture list.

* In addition to A/¥, you can also select an item by pressing the
same number button as indicated on the number tab.

* To display the rest of the list, press > (repeatedly).

* If an invalid operation is performed, & appears at the bottom of
the screen.
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9 Press A/VY to select the desired picture from the list,
then press Enter.

The Picture appears.

Operations on the Picture viewer
On the Picture viewer, the following operations can be
performed.

e — Gurrent picture number/
Ex@m £ total picture number
Size indicator

Button Operation
> button To display the next picture.
< button To display the previous picture.

@ (size) button | To zoom in/out a page.

Every time you press @ (size), the picture is
magnified in steps and returns to the original
scale after the maximum magnification.

The scale switches in 3 steps (€, @, @ —
indicated at the bottom of the screen).

Enter button | To restore the original scale when the picture
is magnified.
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To scroll the magnified picture

If you zoom in the picture by pressing @ (size), {/aM/~
appear at the edges of the screen.

Press €4/A/V¥/» to scroll the screen.

To view a slideshow of pictures

You can view a slideshow of pictures.

With the slideshow set to on, select the desired picture with
which to start the slideshow from the Picture list.

The slideshow setting can be configured from the Setting

menu (>] page 60).
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Settings

Setting screen orientation

Screen orientation (including menu screens) can be set to
vertical/horizontal.

0 In the Home menu, press A/V to select “Settings,’
then press Enter.

The Setting menu appears.

9 Press A/Y to select “Orientation,” then press Enter.
The orientation is switched from vertical to horizontal.

= Settings
[d) Orientation

- LA
~ |

Y Date and Time

[X Slideshow

(Y, Sleep Mode

=1 Advanced Settings
E3 About o
‘) Restore Defaults

Noo[s[o[~

1]
(2]
2E
k=
O E
w
@
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Setting the Date and Time

You can set the date and time displayed on the Reader.

o In the Home menu, press A/V to select “Settings,’
then press Enter.

The Setting menu appears.

e Press A/V to select “Date and Time,” then press Enter.

e Press A/V to select “Year,” “Month,” “Date,” “Hour,”
and “Minute,” then press the number buttons to
input the date and time.

& Date and Time

Year 2 00|7
Month ' 0|1
Date | 0|1
Hour 0|1

Minute | 0|1

O Press A/Y to select “OK,” then press Enter.

Hint

* When you connect the Reader to your computer with eBook
Library started, the date and time of the Reader is automatically
synchronized with your computer clock.
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Setting the Slideshow

Follow the steps below to configure the slideshow settings.

© In the Home menu, press A/V to select “Settings,’
then press Enter.

The Setting menu appears.

9 Press A/V to select “Slideshow,” then press Enter.
The Slideshow setting screen appears.

9 Press Enter repeatedly to select “Off” or “On.”

The setting switches from “Off” to “On,” and the
slideshow setting is activated.

O Press Y/4/» to select “Slide Duration,” then press
the number buttons to input the duration time.

“Slide Duration” can be set up to 60 seconds in 1
second increments.

= Slideshow
Turn | On

Slide Duration [§] 5 /seconds
OK

~__ @

9 Press </A/V/» to select “OK,’ then press Enter.

* The default setting of Slideshow is “Off.”
* When a large size picture is displayed, it may take longer to display
the picture than the indicated setting time on “Slide Duration.
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Setting the Sleep Mode (Resume
Function)
You can set the Reader to automatically enter sleep mode.

In sleep mode, the Reader automatically turns off if no
operation is performed for 60 minutes (resume function).

© In the Home menu, press A/V to select “Settings,”
then press Enter.

The Setting menu appears.

9 Press A/Y to select “Sleep Mode,”’ then press Enter.
The Sleep Mode setting screen appears.

e Press Enter repeatedly to select “Off,” or “On.”

Off: The Reader does not go into sleep mode.
On: The Reader automatically enter sleep mode.

dy Sleep Mode

-

O Press A/Y to select “OK,” then press Enter.

Continued 61



* The default setting of Sleep Mode is “On.”
* In the following states, the Reader does not automatically turn off if
no operation is performed for 60 minutes.
— When connecting the computer using the supplied USB cable
— When connecting the AC Adaptor for Reader (AC-S5220E)
(optional) to charge
— When playing audio files

Hint
* To reduce the power consumption, the Reader provides the
following two modes.
— Sleep Mode:
Reader can be set to automatically enter Sleep Mode after a
period of inactivity. Once in Sleep Mode, the Reader goes into a
power savings mode and prevents any unintended keypad input.
To turn Reader on again, slide the Power switch and Reader will
immediately resume to show the previously displayed screen.
— Device Shutdown:
Reader can be set to enter Device Shutdown mode. Once in
Device Shutdown Mode, the Reader will no longer consume
power and conserve it's battery for an extended period of time. To
turn Reader on again, slide the Power switch, and the start-up
screen will appear in a few moments. (>] page 66)
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Setting the Advanced Settings

You can lock the Reader, format the built-in flash memory,
and shut down the Reader.

Locking the Reader

You can lock the Reader by setting a password.
Follow the steps below.

o In the Home menu, press A/V to select “Settings,’
then press Enter.

The Setting menu appears.

@ Press A/Y to select “Advanced Settings,” then press
Enter.

The Advanced Settings menu appears.

e Press A/V to select “Device Lock,’ then press Enter.
The Device Lock setting screen appears.

O Press Enter repeatedly to select “Off” or “On.”

The setting switches from “Off” to “On,” and the Device
Lock setting is activated.

* |f the Device Lock is activated, the Reader is not recognized on
your computer and the content cannot be transferred.
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9 Press V/<4/» to select “Code,” then press the
number buttons to input the password.

The 4-digit password is set.

& Device Lock
Turn | On

Code [[§0/0/0
oK

0 Press </A/V/» to select “OK,” then press Enter.

Once the password is set, next time you turn on the Reader,
the screen asking for the password appears.

Press the number buttons to input the password, press ¥ to
select “OK,” then press Enter.

& Device Lock

Enter Code [1/1/1/1

- 10f1

* Be careful not to forget the password.
If you lost your password, please call Sony Support 1-(866)-962-
76609.
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Formatting the internal memory

You can format the built-in flash memory of the Reader. If
the memory is formatted, all content will be erased.

* Be sure to verify the content in memory prior to formatting and
transfer any necessary content to the hard disk of your computer or
other device.

0 In the Home menu, press A/V to select “Settings,”
then press Enter.

The Settings menu appears.

e Press A/V to select “Advanced Settings,’ then press
Enter.

The Advanced Settings menu appears.

e Press A/V to select “Format Internal Memory,” then
press Enter.

0 Press M (MARK) to format the built-in flash memory
of the Reader.
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Shutting down Reader

If you will not be using the Reader for several days, the
power consumption of the battery can be minimized by
shutting down the Reader.

o In the Home menu, press A/Y to select “Settings,’
then press Enter.

The Settings menu appears.

9 Press A/V to select “Advanced Settings,’ then press
Enter.

The Advanced Settings menu appears.

e Press A/Y to select “Device Shutdown,”’ then press
Enter.

O Press (M (MARK) to shut down the Reader.

* When turning on by sliding the POWER switch from this state, the
Reader may take a few moments to turn on.

* When you connect the Reader to your computer after shutting
down, it is necessary to turn on the Reader again. Otherwise, it
takes about 40 minutes until (indicating connection via USB) is
displayed, and you will not be able to turn on the Reader by the
POWER switch during this time. The indicator lights up in red while
is not displayed, and the Reader is charged. In this case,
disconnect the USB cable from the Reader, then turn on the
Reader and reconnect it.
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Checking Version Information for
Reader

The product name and the firmware version of the Reader
can be displayed.

o In the Home menu, press A/Y to select “Settings,’
then press Enter.

The Setting menu appears.

9 Press A/Y to select “About,” then press Enter.
The About screen appears.
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Troubleshooting

Troubleshooting

If the Reader does not function as expected, try the
following steps to resolve the issue.

o Reset the Reader by pressing the Reset button with
a small pin or clip.
The content and settings stored on the Reader are not
affected by resetting, and no information is erased.
After pressing the Reset button, turn on the Reader by
sliding the POWER switch.

* When you connect the Reader to your computer after a reset, it is
necessary to turn on the Reader again. Otherwise, it takes about
40 minutes until (indicating connection via USB) is displayed,
and you will not be able to turn on the Reader by the POWER
switch during this time. The indicator lights up in red while is
not displayed, and the Reader is charged. In this case,
disconnect the USB cable from the Reader, then turn on the
Reader and reconnect it.

9 Check the symptoms in “Troubleshooting.”
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9 Check for information about the issue in eBook

Library Help.

9 Look for information about the issue on one of the
support Web sites.

http://www.sony.com/readersupport

O it the approaches listed above fail to resolve the
issue, please call Sony Support 1-(866)-962-7669.

Power

Symptom

Cause or corrective action

Battery life seems
short.

= The operating temperature is below
5 °C (41 °F). This is due to the
battery characteristics and not a
malfunction.

= You have not used the Reader for a
prolonged period. Efficiency of the
battery will be improved by
repeatedly charging and discharging.

= The battery needs to be replaced.
Consult your nearest Sony Service
Center.

= The battery has not been given
enough time to charge fully.
Charge the battery until the indicator
goes off. (The battery icon does not
indicate remaining battery power
during charging.)
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Power (continued)

Symptom

Cause or corrective action

The Reader cannot
be turned on.

= Moisture condensation may have

occurred. Wait for a few hours and
then turn on the Reader.

= If the battery has been fully depleted,

connect to your computer via USB
and charge the battery (5] page 17).
If the battery has fully been depleted,
it takes about 40 minutes until
(indicating connection via USB) is
displayed, and you will not be able to
turn on the Reader by the POWER
switch during this time. In this case,
wait until is displayed. The
indicator lights up in red while is
not displayed, and the Reader is
charged.

Screen

Symptom

Cause or corrective action

It takes time for the
display to appear.

= In a cold place such as outdoors, it

may take time for the display to
appear.

This is due to the display
characteristics and not a malfunction.

The Reader
authorization/de-
authorization is not
possible with

CONNECT eBooks.

- The Reader authorization/de-

authorization is not possible with
CONNECT eBooks if “Device Lock”
of the Reader is set to “On.” Set it to
“Off,” then authorize/de-authorize the
Reader.
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Reading/playing/viewing contents

Symptom Cause or corrective action
A book cannot be = A book with copyright protection
read. cannot be read on any device other

than the authorized one.

An audio file cannot & Audio files that are not supported by

be played back. the Reader cannot be played. For
details on supported audio files, refer
to [>] page 51.

Sound is not output. < Raise the volume if it is set low.

< If sound is not output through
headphones, make sure the
headphone plug is firmly inserted in
the headphone jack.

A picture cannot be < Picture files that are not supported
displayed. by the Reader cannot be viewed. For
details on supported picture files,
refer to [>] page 55.
= A picture of large size may not be
displayable, and its file will not appear
in the list. Delete the picture file using

eBook Library.
The data on 2 If the file status has changed (such
Continue Reading, as in the following cases), the data
Bookmark or History  on Continue Reading, Bookmark or
of some files is History may be deleted.
missing. ¢ A Text/RTF/PDF file is edited.

* An eBook purchased with a authorized
Reader is read on another de-
authorized Reader by memory card
transfer.
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Connection to the computer

Symptom Cause or corrective action
The Reader cannot & The Reader cannot be operated
be operated during while it is connected to a computer.

USB connection.

The Reader cannot < Is the power of the Reader turned on? Is
be recognized. the USB cable connected properly?
Verify the above and try again.

= Are you using a USB hub or USB
extension cable?
Connecting the Reader via a USB
hub or extension cable may not work
and is not supported. Connect the
USB cable directly to the computer.

< Verify that (indicating connection via
USB) is displayed at the top of the
Reader’s screen. If the Reader still cannot
be recognized, disconnect the USB cable
from the Reader, then reconnect it after a
while.

= If “Device Lock” of the Reader is set
to “On,” set it to “Off.” If the Reader is
locked, it will not be recognized on
your computer.
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Connection to the computer (continued)

Symptom Cause or corrective action

Content cannotbe = The USB cable is not connected
transferred to the properly. Disconnect the USB cable,
Reader from your then reconnect it.

computer.

= There is not enough free space on
the Readers memory. Transfer any
unnecessary content back to eBook
Library, then delete it to increase free
space on the Reader.

There is no response < Disconnect the USB cable from the

from eBook Library Reader, then reconnect it.

during

communication with

the Reader.

The Reader = Are you using a USB hub or USB
becomes unstable extension cable?

while it is connected Connecting the Reader via a USB

to the computer. hub or extension cable may not work

and is not supported. Connect the
USB cable directly to the computer.

The Reader’s battery < Is the USB cable connected

cannot be charged. properly? Verify and try again.
(The indicator does = Are you using a USB hub or USB
not light up.) extension cable? Connecting the

Reader via a USB hub or extension
cable may not work and is not
supported. Connect the USB cable
directly to the computer.

Continued 73"



eBook

Symptom Cause or corrective action
An eBook cannotbe - You may not have signed up for the
read. service or authorized which is

necessary for reading eBooks.
Authorize your computer and the
Reader.

< You may have tried to read the
content owned by another user.
The content owned by another
user cannot be read.

< The authorization data may be
damaged caused by a shut down
while reading an eBook. De-
authorize your computer and the
Reader, then authorize again.
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Memory card

Symptom

Cause or corrective action

Contenton a
memory card cannot
be read/played/
viewed.

< Check that the memory card is
inserted in the Media slot in the
correct direction.

= Check to see that you are using a
memory card that is supported by
the Reader.

< Clean the terminal area of memory
card gently with a soft cloth if it is
dirty.

Content cannot be
transferred to a
memory card.

= Release the erasure prevention
switch if it is locked.

< There is not enough free space on
the memory card. Delete
unnecessary data.

A memory card
cannot be
recognized.

= A memory card which is not
formatted with FAT may not be able
to be recognized on eBook Library.
When formatting a memory card,
format it using the formatter supplied
with the memory card, or using
Windows Explorer by specifying FAT.
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Restoring default settings

All default settings of the Reader can be restored.

The following occurs when you restore the default settings.

* The screen orientation setting will be vertical.

* The password will be erased and the device lock released.

* The Slideshow setting will be set to “Off” and its duration time set
to 5 seconds.

* The volume will return to the default level.

o In the Home menu, press A/Y to select “Settings,”
then press Enter.

The Setting menu appears.

9 Press A/Y to select “Restore Defaults,” then press
Enter.

The Restore Defaults screen appears.

If “Device Lock” (=] page 63) is set to “On,” the screen
asking for the password appears. Input the password,
then select “OK”

9 Press M (MARK) to restore default settings.
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Uninstalling eBook Library

To uninstall the supplied software from your computer, follow
the procedures below.

* Before uninstalling, de-authorize your computer if it is authorized.
For details on de-authorization, refer to the eBook Library Help.

o Click “Start” — “Control Panel.”

© Double-click “Add/Remove Programs.” *!

9 Click “eBook Library by Sony” in the “Currently
Installed Programs” list, then click “Remove.” *2
Follow the on-screen instructions and restart your
computer. The uninstallation is complete when the
computer has restarted.

Uninstalling PRS-505 User’s Guide

1 Click “Start”’-“Control Panel.”

2 Double-click “Add/Remove Programs.” *'

3 Click “PRS-505 User’s Guide” in the “Currently Installed
Programs” list, then click “Remove.” *2
Follow the on-screen instructions and restart your computer. The
uninstallation is complete when the computer has restarted.

*1 “Uninstall a program” or “Programs and Features” in the case of
Windows Vista.
*2 “Uninstall” in the case of Windows Vista.
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Other Information

Updating the Reader’s Firmware

By updating the Reader’s firmware, you can ensure your
Reader has the latest features. The latest firmware updates
can be performed from the update menu on eBook Library
from “Help” — “Check for Updates.”

For details on updates, refer to the eBook Library Help or
the following website.

http://www.sony.com/readersupport
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About Books Pre-installed on
Reader

The Reader is pre-installed with sample data so that you
can try it out right away. The pre-installed sample data is for
the purpose of trial reading, viewing and listening.
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Notes on Reader Disposal

The built-in rechargeable battery of the Reader is recyclable.
Do not remove the battery yourself, consult “Sony Portable
Reader System Support Center” (=] page 83).

€5

Li-ion Mn
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Precautions

Owner’s Record

The model and serial numbers are located on the back of
the unit. Record the serial number in the space provided
below. Refer to these numbers whenever you call upon your
Sony dealer regarding this product.

Model No.

Serial No.
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For Customers in the USA

INFORMATION:

This equipment has been tested and found to comply with

the limits for a Class B digital device, pursuant to Part 15 of

the FCC Rules. These limits are designed to provide

reasonable protection against harmful interference in a

residential installation. This equipment generates, uses, and

can radiate radio frequency energy and, if not installed and

used in accordance with the instructions, may cause harmful

interference to radio communications.

However, there is no guarantee that interference will not occur

in a particular installation. If this equipment does cause

harmful interference to radio or television reception, which can

be determined by turning the equipment off and on, the user is

encouraged to try to correct the interference by one or more of

the following measures:

— Reorient or relocate the receiving antenna.

— Increase the separation between the equipment and
receiver.

— Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.

— Consult the dealer or an experienced radio/TV technician
for help.

You are cautioned that any changes or modifications not

expressly approved in this manual could void your authority

to operate this equipment.

82 us



If you have any questions about this product:

Visit:
www.sony.com/readersupport
Contact:

Sony Portable Reader System Support Center at 1-(866)-

962-7669

Write:

Sony Customer Information Services Center
12451 Gateway Blvd., Fort Myers, FL 33913

Declaration of Conformity

Trade Name: SONY

Model No.: PRS-505

Responsible Party: Sony Electronics Inc.

Address: 16530 Via Esprillo,
San Diego, CA 92127
U.S.A.

Telephone Number: 858-942-2230

This device complies with Part 15 of the
FCC Rules. Operation is subject to the
following two conditions: (1) This device
may not cause harmful interference, and
(2) this device must accept any
interference received, including
interference that may cause undesired
operation.
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For Customers in the USA and Canada
RECYCLING LITHIUM-ION BATTERIES

Lithium-ion batteries are recyclable. RETICL
You can help preserve our environment by returning
your used rechargeable batteries to the collection \0.572. 5
and recycling location nearest you.

For more information regarding recycling of rechargeable
batteries, call toll free 1-800-822-8837, or visit http://www.
rbrc.org/.

Caution: Do not handle damaged or leaking Lithium-ion
batteries.

* Do not insert any foreign objects in the DC IN jack of the
Reader.

* Be sure not to short-circuit the terminals of the Reader
with metallic objects.

On installation

* Never subject the Reader to extremes of light,
temperature, moisture or vibration.

* Never wrap the Reader in anything when it is being used
with the AC power adapter. Heat build-up in the Reader
may cause malfunction or damage.
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On heat build-up

Heat may build up in the Reader while charging, or if it is
used for an extended period of time.

On the headphones

Road safety

Do not use headphones while driving, cycling, or operating
any motorized vehicle. It may create a traffic hazard and is
illegal in many areas. It can also be potentially dangerous to
play at a high volume while walking, especially at pedestrian
crossings. You should exercise extreme caution or
discontinue use in potentially hazardous situations.

Preventing hearing damage

Avoid using the headphones at a high volume. Hearing
experts advise against continuous, loud and extended play.
If you experience a ringing in your ears, reduce the volume
or discontinue use.

Caring for others

Keep the volume at a moderate level. This will allow you to
hear outside sounds and to be considerate to the people
around you.

Warning

If lightning occurs while you are using the Reader, take off
the headphones immediately.
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Notes on memory cards

About “Memory Stick Duo”

“Memory Stick Duo” is a high-capacity compact IC recording
media. Not only can you exchange data among “Memory
Stick Duo” compatible devices, but also you can use as an
external removable data storage.

About SD Memory Card

SD Memory Card complies with compact memory card
standard and is commonly used as a storage media for
digital still cameras.

For details on memory cards supported by the Reader, refer
to “Inserting a Memory Card” on [>] page 19.

Notes on handling memory cards
* When using miniSD Card on the Reader, an adaptor (sold
separately) is required.

* The Reader does not comply with the following:
— MagicGate standard.
— copyright protection of SD Memory Cards.
- high-speed transfer of SD Memory Cards.
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* You cannot record or delete data stored in a memory card
when its erasure prevention switch is locked.

i

14JL>E4 ¥ I

~HIO0T

* Keep a memory card in its case when you carry or store it.

* Do not touch the connector of a memory card with bear
hands or metallic objects.

* Do not bend, drop, or subject a memory card to excessive
shock.

* Do not disassemble or modify a memory card.

* Do not allow a memory card to get wet.

* Avoid the following to prevent data damage. Sony does not

provide any guarantee for damaged data.

— Remove a memory card or turn off the Reader while reading or
writing data.

— Operate the Reader in the location where static charge or
electrical noise is present.

¢ Do not use a label other than the dedicated one in the
label area.

* Do not use or store the Reader in a location subject:
— extreme high temperature, such as in a sun-heated car.

— direct sunlight.
— high humidity or places with corrosive substances.
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* Copyright laws prohibit reproducing the software or the
manual accompanying it in whole or in part, or renting the
software without the permission of the copyright holder.

* In no event will SONY be liable for any financial damage,
or loss of profits, including claims made by third parties,
arising out of the use of the software supplied with this
Reader.

* In the event a problem occurring with this software as a
result of defective manufacturing, SONY will replace it.
However, SONY bears no other responsibility.

* The software provided with this Reader cannot be used
with equipment other than that which is so designated.

* Please note that, due to continued efforts to improve quality,
software specifications may be changed without notice.

* Operation of this Reader with software other than that
provided is not covered by the warranty.

* The ability to display the languages on your eBook Library
will depend on the OS installed on your computer. For
better results, please ensure that the installed OS is
compatible with the desired language you want to display.
— We do not guarantee all the languages will be able to be

displayed properly on your eBook Library.
— User-created characters and some special characters may not
be displayed.

* Explanations in this manual assume that you are familiar
with the basic operations of Windows. For details on the
use of your computer and operating system, please refer
to the respective manuals.
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On Cleaning

* Clean the case of the Reader with a soft cloth, such as a
cleaning cloth for eyeglasses.

e If the case of the Reader becomes very dirty, clean it with
a soft cloth slightly moistened with water or a mild
detergent solution.

* Do not use any type of abrasive pad, scouring powder, or
solvent, such as alcohol or benzene, as it may mar the
finish of the case.

* Be careful not to let water get into the Reader from the
opening near the connector.

* Clean the headphone plug periodically.

If you have any questions or problems concerning the
Reader, consult your nearest Sony dealer.

* Recorded content is limited to private use only. Use of the
content beyond this limit requires permission of the copyright
holders.

* Sony is not responsible for incomplete recording/downloading or
damaged data due to problems of the Reader or computer.
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On Copyrights

The contents of each book pre-installed on this product
are copyrighted works, edited with the cooperation of the
publisher and editor hereto mentioned.

Copyright laws prohibit copying the data of this product or
the contents of this manual (illustrations, related
documents, etc.) in whole or in part without the permission
of the copyright holder. Additionally, use of the data of this
product or the contents of this manual is not allowed
without Sony’s permission except for personal use.

* SONY and the SONY logo are registered trademarks of Sony
Corporation.

* BBeB, BBeB Book, and their logos are trademarks of Sony
Corporation.

* “Memory Stick,” “Memory Stick Duo,” “Memory Stick PRO Duo,”
and their logos are trademarks of Sony Corporation.

* Bitstream is a registered trademark, and Dutch, Font Fusion,
and Swiss are trademarks, of Bitstream Inc.

* Microsoft, Windows, Windows Vista and Windows Media are
trademarks or registered trademarks of Microsoft Corporation in
the United States and / or other countries.

* Adobe, Adobe Reader and Adobe PDF are trademarks or
registered trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

* MPEG Layer-3 audio coding technology and patents licensed
from Fraunhofer IS and Thomson.
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* This product uses MontaVista Software, Inc’s MontaVista(R)
Linux(R) Professional Edition as the operating system.
COPYRIGHT ©1999-2006 MONTAVISTA
SOFTWARE, INC. ALL RIGHTS
RESERVED. montavista’
http://www.mvista.com/

* MontaVista is a registered trademark of MontaVista Software, Inc.

* This product includes software developed by the OpenSSL
Project for use in the OpenSSL Toolkit.
(<http://www.openssl.org/>) Copyright © 1998-2006 The
OpenSSL Project. All rights reserved. This product includes
cryptographic software written by Eric Young (eay @ cryptsoft.
com). This product includes software written by Tim Hudson
(tih@cryptsoft.com). For details on OpenSSL License, refer to
“openssl.ixt” on the CD-ROM.

All other system names and product names appearing in this
document are generally the registered trademarks or trademarks
of their respective manufacturers. Further, the trademark ™ and
registered trademark ® symbols are not indicated throughout this
document.

Program ©2006, 2007 Sony Corporation
Documentation ©2006, 2007 Sony Corporation

About GNU GENERAL PUBLIC LICENSE

Dear customers

Thank you for purchasing this product.

Included with this product is the following software which
applies to GPL/LGPL. You may obtain, modify and
redistribute the source codes of the software.

bash
fileutils
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findutils
gcc

glib

glibc

grep
hardhatutils
hosthame
mkcramfs
mtd-utils
mtools
ncurses
pam
procps
psmisc
sed
shellutils
sysutils
sysvinit
tar
textutils
time
util-linux

These source codes are available on the web site.

Access the following web site to download.
http://www.sony.net/Products/Linux/

Note that Sony accepts no inquiries concerning the contents
of these source codes.

For details on GNU GENERAL PUBLIC LICENSE, refer to
“gpl.txt” and “Igpl.txt” on the CD-ROM.
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Specifications

Model name
PRS-505

Power source
Built-in rechargeable battery: DC 3.7 V
AC power adapter: DC 5.2V

Battery life (continuous playback)
Approx. 7500 pages (when the battery is fully charged)

User available capacity
Approx. 192MB
Available storage capacity of the Reader may vary.

Operating temperature
5 to 35 °C (41 to 95 °F)

Dimensions (w/h/d)
Approx. 6.9 x 4.8 x 0.3 inches
(maximum, without soft cover)

Mass
Approx. 9 oz (without soft cover)

Optional Accessories
AC Adaptor for Reader: AC-S5220E

Design and specifications are subject to change without
notice.
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A propos des manuels

Le Guide de démarrage et le présent Guide de I'utilisateur m
au format PDF sont livrés avec le Reader. Aprés avoir

installé votre logiciel eBook Library a I'aide du CD-ROM

fourni, vous pouvez également vous reporter a I’Aide eBook
Library.

Navigation dans le Guide de I'utilisateur

Ce Guide de l'utilisateur au format PDF peut étre consulté
sur un ordinateur, mais également sur le Reader.

Pour naviguer dans le Guide de l'utilisateur
avec votre ordinateur

Cliquez sur le menu Démarrer en bas a gauche du Bureau,
puis sélectionnez « Tous les programmes » — « Reader » —
« PRS-505 User’s Guide » pour lancer Adobe Reader et
ouvrir le Guide de l'utilisateur.

Pour plus d’'informations sur 'utilisation du logiciel Adobe
Reader, reportez-vous a I'Aide Adobe Reader.

Conseil

* Vous devez installer Adobe Reader, version 5.0 ou ultérieure, pour
visualiser le Guide de l'utilisateur. Vous pouvez télécharger
gratuitement Adobe Reader directement depuis le site Adobe
(www.adobe.com).
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Pour naviguer dans le Guide de lutilisateur
avec le Reader

Dans le menu d’accueil, sélectionnez « Books by Title » — « User’s
Guide » dans la liste de livres. Vous pouvez ouvrir le Guide de
I'utilisateur en sélectionnant « Option Menu » — « Begin ».

Lien PDF

=l Touche @ (taille)

Conseils

* Le signe [>] sur le Guide de l'utilisateur indique un lien. Pour sélectionner
le lien de votre choix, utilisez les touches <4/V/A/»/Entrée. Appuyez sur
A/V puis appuyez sur Entrée pour ouvrir la page souhaitée.

* Pour effectuer un zoom dans la page, appuyez sur la touche @ (taille).

Pour plus d’informations sur 'ouverture de livres ou de fichiers
PDF, voir [>] pages 35, 39.

Utilisation de I’Aide eBook Library

Pour plus d’'informations sur l'utilisation du logiciel eBook
Library, comme par exemple, sur I'importation de livres sur
votre ordinateur ou bien encore le transfert de livres vers le
Reader, reportez-vous a I'’Aide eBook Library.

Suivez les étapes ci-dessous pour lancer eBook Library et parcourir I'Aide.

o Cliquez sur le menu Démarrer de votre ordinateur, puis sélectionnez
« Tous les programmes » - « Reader » — « eBook Library ».

9 Cliquez sur « Help » - « eBook Library Help » sur la barre de menus.
LAide apparait.
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LeCtUIe de lIVIES ...ueeeeeieiie e 35
Lecture de livres transférés depuis votre ordinateur................... 35
Acceés direct a la page indiqUée..........cccuveeeiiiiiiiiiiie e 40
Modification de 'orientation de I'écran (verticale/horizontale)....41
Affichage des informations relatives au livre ........cc.c.cccieeeeene 42
Classement de la liste de livres .......cueeeeiiiiiiiiiiiieee 43
Sélection d’un livre dans la liste de collections...........ccccccceeee..e. 46
Création d’un signet sur une page.........coceevieeeeiieeeeiiieee e 47
Lecture des pages précédemment affichées............ccccoeineeeen. 50

Lecture de fichiers audio ..o 51
Lecture de fichiers audio transférés depuis votre ordinateur......51
Lecture de livres et d'un fichier audio simultanée....................... 53

Visualisation d'iMages .......coveeuruiiiiiiieiii e 55
Visualisation d’images transférées depuis votre ordinateur ....... 55

Parameétres

Réglage de l'orientation de P'écran........c.cccccooviiiiiiiiiiiicicnneneeenn, 58

Réglage de la date et de 'heure ..., 59

Réglage du diaporama..........coocceiiiiiiiiiiiiee e 60

Réglage du mode de veille (fonction de reprise) ..........ueveeeceennnn. 61

REQIAgEs QVANCES. ......cccceiiiiiiiiireee e 63
Verrouillage du Reader........ccccceueiiiiiiiieiiieieeeeee e 63
Formatage de la mémoire interne .........cccoceeeiiiiiiiec e 65
Arrét du Reader .. ... 66

Vérification des informations relatives a la version du Reader.... 67

Suite 5™



Dépannage

DEPANNAgE .. .ccoiiiieiieiieeee e 68
Restauration des parametres par défaut ..........occccvveeveeeiicinnennn. 76
Désinstallation de eBook Library.........cccccceeiiiiiiiiiiiiiiiieieeceeeeen, 77

Informations complémentaires

Mise a jour du micrologiciel du Reader .........cccccccoeviiiiiiiiiiiiinneen. 78
A propos des livres pré-installés sur le Reader...............ccc......... 79
Remarques sur la mise au rebut du Reader.........ccccccoevevveeinnnnnnn. 80
PréCautioNS.......ccceiiiiiiie e 81
SECUNEE ... 83
INSTAIATION oo 83
Surchauffe INTErNe .........cccvvviiieiiieeieeee e 84
ECOULBUIS ...t en s sn s s nananens 84
A propos des cartes MEMOIre. ...........cccveueueveeeverereeceeeeeeeenenanes 85
LOGICIEIS ... 87
ENntretion ... 88
A propos des droits d’auteur .............cccoveveeeeeeieeeeeee e 89
A propos de la LICENCE PUBLIQUE GENERALE GNU............ 90
Caractéristiques teChNIQUES.........cceeeiiiiiiiieeee e, 92
T = 93

GFR



Présentation

Utilisation du Reader

Lisez tout d’abord le Guide de démarrage avant d’utiliser
votre Reader. Avant toute premiére utilisation du Reader,
vous devez charger la batterie et installer le logiciel dédié
« eBook Library » sur votre ordinateur.

Une fois ces opérations effectuées, vous pouvez transférer
le contenu de votre ordinateur vers le Reader afin de
'emporter partout ou vous le souhaitez.

eBooks
«  téléchargés

*T CONNECT eBooks (librairie en ligne e-Book)
*2 Fichiers Livres/Fichiers audio/lmages dont vous disposez déja

(Mise en service ) Chargez la batterie de votre Reader, puis installez le
logiciel eBook Library sur votre ordinateur.

4
3 =2

" , Visualisation
Téléchargez sur votre Transférez du contenu
ordinateur le logiciel depuis votre ordinateur Profitez de ce contenu sur
eBooks depuisla librairie en vers le Reader en utilisant  votre Reader.
ligne CONNECT eBooks. eBook Library.
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Composants et commandes
@ @ 7] 6]

Avant

[1] Touche Entrée*'
Appuyez sur la touche Entrée pour sélectionner /- Touche
un élement ou appliquer un réglage. \ @ Entrée

[2] Touches </A/VY/»*!
Appuyez sur les touches « (gauche), A (haut), ¥ (bas)

ou p (droite) pour sélectionner un élément ou faire
défiler I'écran.

v

** Dans ce manuel, le fonctionnement des touches «4/A/¥/»/Entrée est
expliqué comme suit :
(Exemple) Appuyez sur les touches <4/A/V/» pour sélectionner
« Away » dans la liste de livres, puis appuyez sur la touche Entrée.
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Touche MENU
Permet de revenir a I'écran précédent ou d’afficher un
menu. (] page 13)

(4] Touches M (page) / (>/<)
Permettent de tourner la page ou de passer au contenu
suivant (>), et de revenir au contenu précédent (<).
(=] pages 36, 38, 53, 56)

Touches numériques (1 - 9,0)
Permettent de sélectionner les éléments numérotés a
I'écran ou de saisir des valeurs numériques dans le
menu de réglage. (>] pages 36, 38, 51, 55)

(6] Fente d’insertion de la carte mémoire SD
Permet d’insérer une carte mémoire SD (en option).

(> page 20)

Fente d’insertion du « Memory Stick Duo »
Permet d’insérer un « Memory Stick Duo » (en option).

(=] page 20)

Commutateur POWER
Permet d’allumer et/ou d’éteindre le Reader. (>] page 15)
[9] Témoin
Un témoin rouge s’allume pendant le chargement de la
batterie et s’éteint lorsque le chargement est terminé.
(=] page 17)
Le témoin clignote en orange lorsque le Reader accede
a votre ordinateur via un raccordement USB.
Il clignote également en orange lors de la mise sous
tension ou hors tension du Reader.
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Orifices de fixation de I’étui souple
L'étui souple est mis en place lors de I'achat. (>] page 12)
Se plie lors de l'utilisation

_—

O

Remarque

* N’exposez pas votre Reader a des températures élevées pour
éviter tout risque de détérioration de I'étui souple.

Touche @ (taille)
Permet d’effectuer des zooms avant/arrieére sur une page
ou une image. (] pages 39, 56)

Touche 1 (MARQUE)
Permet de créer et/ou de déplacer un signet. (>] page 47)

Anneau de fixation de la dragonne
Permet d’attacher la dragonne.

Connecteur USB
Permet de connecter le cable USB (fourni). (=] page 28)

Prise DC IN
Permet de connecter un adaptateur CA (en option).

Conseil
* Vous pouvez charger votre Reader en le connectant a un
ordinateur a I'aide du céble USB fourni.
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Prise () (Ecouteurs)
Permet de brancher les écouteurs (en option).

(=] page 51)

Touches VOLUME +/-
Permettent de régler le volume. (] page 53)
Pour activer la fonction de sourdine, maintenez les
touches VOLUME +/— enfoncées. Pour désactiver la
fonction de sourdine, appuyez de nouveau sur les
touches VOLUME +/—.

Arriéere

Touche Reset
Permet de réinitialiser le Reader si aucune opération
n’est possible. (=] page 68)
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A propos du numéro de série

Le numéro de série fourni avec le Reader est requis lors de
'enregistrement du client. Ce numéro est inscrit sur
I'étiquette collée au dos de votre Reader. Ne retirez jamais
cette étiquette.

Retirer et/ou fixer I’étui souple
=»B]

Retrait de I’étui souple
(@ Tirez la languette de I'étui souple vers I'extérieur [A].
(@ Retirez le Reader dans le sens de [B].

Fixation de I’étui souple

@ Insérez la languette [C] de I'étui souple dans l'orifice [D]
du Reader.

(@ Tirez la languette de I'étui souple dans le sens de [A].

(® Insérez le Reader dans le sens de [E] pour le fixer sur
I'étui souple.

(@ Vérifiez si les languettes de I'étui souple sont bien
insérées dans les orifices du Reader.

Remarque

* Notez que la languette de I'étui souple peut se déformer si vous
tirez trop fort dessus.
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Opérations de base

Fonctionnement des menus

Vous pouvez passer d’'un écran a un autre, pour lire/écouter/
visualiser du contenu ou pour régler les paramétres, a 'aide des
touches </A/¥/»/Entrée, des touches numériques ou du MENU.
Exemple : schéma de transition d’écrans du menu d’accueil
a la liste de livres au menu d’options et a la page du livre

Continue Reading .
[ Books by Title o
& Books by Author
Books by Date
Wil Collections

[T All Bookmarks .
1l Now Playing
13 Audio
[ Pictures
£ Settings
=1

Appuyez sur la

touche MENU pour

revenir a I’écran
précédent.

ool N[0 lulslc W=

=

Boutons numérotés
L’élément sélectionné est surligné en noir.

Appuyez sur les touches A/ pour sélectionner
« Books by Title » puis appuyez sur Entrée.

Si plus de 30 livres sont stockes, le
menu Index apparait. ( [>] pages 43, 45)

ER) Amusements in Mathematics
R A Christmas Carol

[ER) Dream Psychology

£R Emma

R Les Miserables

Appuyez sur les touches A/V
pour sélectionner puis appuyez
sur Entrée.

[ER Metamorphosis i
8 Moby Dick, or, the whale
£8 A Study in Scarlet _

£R The Time Machine '7 _ : Appuyez sur
Moo | SR les touches
- A/V pour
—K & oot oriens " sélectionner
 stry - puis appuyez
& vines sur Entrée.

o © 10126
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Conseils

* En maintenant la touche @ (taille) enfoncée, vous pouvez changer
I'orientation de I'écran (verticale/horizontale). ([>] page 41)

e En utilisant les touches numériques correspondantes, vous pouvez
sélectionner les éléments numérotés.

e En maintenant la touche MENU enfoncée, vous pouvez revenir au
menu d’accueil.
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Mise sous tension du Reader

Faites glisser le commutateur POWER dans le sens de »
pour mettre le Reader sous tension.

Faites glisser le
commutateur POWER.

Le Reader s’allume.

A la premiere mise en service de I'appareil, aprés une
réinitialisation ou lorsque que la batterie est épuisée,
quelques instants d’attente sont parfois nécessaires avant
que le Reader s’allume et que I'écran de démarrage
n‘apparaisse.

Le témoin s’allume en orange quand le Reader est sous
tension.

Pour éteindre le Reader

Faites de nouveau glisser le commutateur POWER dans le
sens de ».

Le Reader s’éteint.
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A propos du mode de veille (fonction de
reprise)

Vous pouvez configurer le Reader pour qu’il passe
automatiquement en mode de veille. En mode de veille, le
Reader se met automatiquement hors tension lorsqu’il reste
inutilisé pendant 60 minutes (fonction de reprise). Lécran
précédemment affiché apparait lorsque vous faites glisser le
commutateur POWER pour allumer I'appareil.

Vous pouvez configurer le mode de veille dans le menu de

réglages (] page 61).

Remarque

* Dans les cas suivants, le Reader ne se met pas automatiquement
hors tension lorsqu’il reste inutilisé pendant 60 minutes.
— Lorsque 'appareil est raccordé a I'ordinateur a I'aide du céble
USB fourni
— Lorsqu’il est raccordé a I'adaptateur CA pour le Reader
AC-S5220E (en option) pour la charge
— Lors de la lecture de fichiers audio
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A propos du chargement de la batterie
Vous devez charger le Reader avant sa premiere utilisation.
Mettez le Reader sous tension, puis chargez-le de I'une des

deux fagons suivantes.

* Raccordez I'appareil a un ordinateur via le cable USB (voir Guide
de démarrage ou [>] page 27 ).
(Temps de charge : environ 4 heures®)

* Raccordez I'appareil a une prise CA via un adaptateur CA et un
cordon d’alimentation CA (en option).
(Temps de charge : environ 2 heures®)
* Temps approximatif pour que la batterie soit complétement chargée.

Remarques

* Lorsque vous raccordez le Reader a votre ordinateur, I'indication
(connexion USB) s’affiche a I'écran du Reader. Si la batterie
est completement épuisée, I'indication peut mettre environ
40 minutes a s’afficher. Vous ne pourrez pas mettre le Reader sous
tension a I'aide du commutateur POWER pendant ce temps. Dans
ce cas, attendez que l'indication s’affiche. Un témoin rouge
s’allume lors du chargement du Reader si I'indication ne
s’affiche pas a I'écran.

* Si le niveau d’autonomie de 'ordinateur portable auquel vous étes
raccordé est faible, il est impossible de procéder a un chargement
via une connexion USB.

* Si vous raccordez le Reader a un ordinateur portable qui n’est pas
branché sur une prise CA, vous risquez d’épuiser la batterie de
I'ordinateur. Ne laissez jamais votre Reader raccordé a un
ordinateur portable qui n’est pas branché sur une prise CA
pendant une période prolongée.

* Le raccordement du Reader via un concentrateur ou une rallonge
USB n’est pas pris en charge et risque de ne pas fonctionner.
Raccordez le cable USB directement a I'ordinateur.
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Vous pouvez surveiller le niveau d’autonomie gréace
lindicateur en bas a gauche de I'écran. Chargez de
préférence la batterie lorsque le niveau d’autonomie est
faible (le niveau d’autonomie est faible lorsqu’il ne reste plus
gu’un seul segment noir affiché).

(T [ LT o (T g o g ) o

¢ Si le niveau d’autonomie est faible, 'avertissement suivant
apparait. Mettez la batterie en charge.

Si vous continuez a utiliser 'appareil sans recharger la batterie,
I'avertissement suivant apparait, puis le Reader s’éteint
automatiquement.

Chargez le Reader avant de I'allumer de nouveau.
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Insertion d’une carte mémoire

Vous pouvez insérer les cartes mémoire suivantes dans les
fentes pour carte mémoire de votre Reader.

Remarque

* Le Reader dispose de fentes séparées pour les « Memory Stick Duo »
et les cartes mémoire SD. Assurez-vous d’insérer la carte mémoire
dans la fente appropriée. Linsertion de la carte mémoire dans la
mauvaise fente peut endommager la fente ainsi que la carte mémoire.

« Memory Stick Duo »" | « Memory Stick Duo »
« Memory Stick PRO Duo »

Carte mémoire SD™ Carte mémoire SD
Carte miniSD™

*! Le Reader n’est pas compatible avec la norme MagicGate. De plus,
les données qui requierent la fonction de protection des droits
d’auteur ne peuvent pas étre copiées ou lues sur le Reader.

*2 Le Reader n'est pas compatible avec la protection des droits d’auteur
des cartes mémoire SD.

*3 Un adaptateur pour carte miniSD (vendu séparément) est requis.

Remarques

* Avec les « Memory Stick Duo » d’une capacité maximum de 8 Go,
un contr6le de compatibilité est effectué. Cependant, la compatibilité
avec tous les « Memory Stick Duo » n’est en aucun cas garantie.

* Avec les cartes mémoire SD d’une capacité maximum de 2 Go, un
contréle de compatibilité est effectué. Cependant, la compatibilité
avec toutes les cartes mémoire SD n’est en aucun cas garantie.

¢ Lorsque vous insérez la carte mémoire dans le Reader, la
reconnaissance des fichiers de contenu peut prendre quelques
instants, surtout si la taille des fichiers de contenu stockés sur
cette carte mémoire est importante.
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Pour insérer une carte mémoire dans le
Reader

o Retirez les cartes factices de la fente pour « Memory
Stick Duo » et de la fente pour carte mémoire SD.
Les cartes factices sont insérées dans la fente pour
« Memory Stick Duo » et la fente pour carte mémoire
SD a l'achat. Lorsque vous n’utilisez pas de carte
meémoire, insérez la carte factice dans la fente.

Remarque

* Si la carte factice n’est pas insérée dans la fente, des corps
étrangers risquent d’y pénétrer, ce qui peut entrainer des
problémes de fonctionnement ou des dommages.
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9 Insérez une carte mémoire dans le sens de la
marque » avec I'étiquette vers le haut jusqu’au

déclic de mise en place.

Remarque

* Le Reader dispose de fentes séparées pour les « Memory Stick
Duo » et les cartes mémoire SD. Assurez-vous d’insérer la carte
mémoire dans la fente appropriée. Linsertion de la carte mémoire
dans la mauvaise fente peut endommager la fente ainsi que la
carte mémoire.

( )

« Memory  Carte

Stick Duo » mémoire SD

L)
Marque +—=/) = Marque
4

>.;::2“CC.;.= =5

Remarques

» Assurez-vous d’'insérer la carte mémoire dans le bon sens. Si vous
forcez pour insérer la carte, cela peut endommager la fente.

* N’insérez jamais une carte mémoire incompatible dans I'appareil,
vous risquez d’entrainer des problemes de fonctionnement.

* N’utilisez jamais une carte mémoire ou un adaptateur déformé.
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Pour retirer une carte mémoire du Reader

(1) Appliquez une légére pression sur la carte mémoire.
Au clic, la carte mémoire est éjectée de I'appareil.

( )

« Memory Carte
Stick Duo » mémoire SD

9 Retirez complétement la carte mémoire de la fente
pour « Memory Stick Duo » ou pour carte mémoire
SD.

Remarques

* Ne retirez jamais la carte mémoire ou n’éteignez jamais le Reader
pendant la lecture ou I'écriture de données, vous risquez de perdre
des données.

e Pour plus d’informations sur I'utilisation des cartes mémoire, voir
page 85.
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Importation de livres électroniques

Importation de eBooks depuis
CONNECT eBooks

Vous pouvez télécharger des eBooks depuis la librairie en
ligne « CONNECT eBooks » sur votre ordinateur.

Utilisez le logiciel dédié eBook Library pour accéder a
CONNECT eBooks.

Remarques

* Pour télécharger des eBooks, votre ordinateur doit disposer d’un
acces Internet.

* Vous devez autoriser votre ordinateur a accéder a CONNECT
eBooks pour télécharger des eBooks.
Vous devez également autoriser votre Reader a accéder a
CONNECT eBooks pour transférer et lire des eBooks téléchargés
sur votre Reader.
Pour plus d'informations, reportez-vous a I’Aide eBook Library.

(1) Double-cliquez sur I'icone eBook Library () sur le
bureau Windows.

Conseil

* Vous pouvez également démarrer le logiciel eBook Library en
cliqguant sur le menu Démarrer, puis en sélectionnant « Tous les
programmes » — « Reader » — « eBook Library ».

(2] Cliquez sur « eBook Store » dans I’affichage par
source.
La zone d’affichage passe a I'affichage par stockage et
CONNECT eBooks apparait.
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9 Suivez les instructions de la page pour acheter des
eBooks (téléchargement).
Les eBooks téléchargés sont automatiquement
importés dans « Library » dans I'affichage par source.

=H————1_ Contenu

téléchargé

|+

c T
Affichage par source

Conseil
* Les eBooks achetés sont regroupés dans le dossier « Purchased »
de la collection.

Conseils

* Vous pouvez lire les eBooks sur votre ordinateur a partir de eBook
Library. Pour plus d’informations sur l'utilisation de eBook Library,
reportez-vous a I'’Aide eBook Library.

e Laffichage par source peut différer d’'un ordinateur a un autre.
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Importation de contenu depuis
votre ordinateur

Vous pouvez importer des fichiers de contenu stockés en
local sur votre ordinateur dans la Library de eBook Library.

Il est possible d’importer les types de fichier de contenu

suivants.
e Livre
Format PDF, texte, RTF, Word*, BBeB
¢ Audio
Fichiers audio au format AAC et MP3 décryptés
— Fichier MP3 (extension de fichier .mp3)
Les spécifications suivantes sont requises pour 'importation de
fichiers MP3.
Débit binaire : 32 a 320 kbit/s
Fréquence d’échantillonnage : 22,05, 44,1 kHz
— Fichier AAC (extension de fichier .mp4, .m4a, .mov ou .qt)
Les spécifications suivantes sont requises pour I'importation de
fichiers AAC.
Débit binaire : 40 a 320 kbit/s
Fréquence d’échantillonnage : 24,0, 44,1, 48,0 kHz
* Image
Format Bitmap, JPEG, GIF, PNG

* Les fichiers Word sont automatiquement convertis en fichiers RTF
pendant le transfert, a condition que Microsoft Word soit installé
sur votre ordinateur.

Pour plus d’'informations sur 'importation de fichiers de
contenu, reportez-vous a 'Aide eBook Library.
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Importation de fichiers de contenu

Vous pouvez sélectionner des fichiers de contenu stockés
en local sur votre ordinateur et les importer dans Library.

o Cliquez sur le menu Démarrer, puis sélectionnez
« Tous les programmes » — « Reader » — « eBook
Library » pour lancer eBook Library.

9 Cliquez sur « Import Files » dans le menu « File ».
La boite de dialogue « Import Files » apparait.

9 Cliquez dans | la liste « Look in » pour sélectionner
le dossier contenant le ou les fichier(s) que vous
souhaitez importer.

Les fichiers de contenu du dossier sélectionné sont
répertoriés.
Conseil

* Vous pouvez également double-cliquer sur le dossier (dans la
liste de dossiers) pour afficher les fichiers de contenu.

0 Sélectionnez le fichier de contenu que vous
souhaitez importer.
Cliquez sur les fichiers tout en maintenant la touche Ctrl
enfoncée pour sélectionner plusieurs fichiers a la fois.

Q Cliquez sur « Open ».
Le ou les fichier(s) de contenu sont importés dans Library.

Conseil

* Vous pouvez importer simultanément tous les fichiers contenus
dans un dossier Library en cliquant sur « Import Folder » dans le
menu « File ».
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Transfert de contenu

Transfert de contenu vers le
Reader depuis votre ordinateur

Vous pouvez transférer (copier) le contenu de la Library sur
le Reader.

Remarque

* Sile Reader est verrouillé, il ne sera pas reconnu par votre
ordinateur et le transfert de contenu sera impossible. (] page 63)
Si le Reader est connecté a votre ordinateur, débranchez-le et
déverrouillez le Reader en saisissant le mot de passe.

Conseils

* Le contenu de livres peut étre regroupé dans la Library sous forme
de collection, qui peut ensuite étre transférées sur le Reader. Pour
plus de détails sur la création et le transfert d’'une collection,
reportez-vous a I'aide eBook Library.

* Vous pouvez synchroniser le contenu de votre eBook Library avec
le Reader en sélectionnant un dossier (tel que « Library » ou ses
sous-dossiers). (=] page 34) Le Reader peut étre mis a jour
automatiquement pour correspondre au contenu de la Library, lors
du raccordement a votre ordinateur.

(1) Cliquez sur le menu Démarrer, puis sélectionnez
« Tous les programmes » — « Reader » — « eBook
Library » pour lancer eBook Library.
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9 Raccordez le Reader a votre ordinateur a I'aide du
cable USB fourni.

Vers le connecteur USB

Cable USB\(&

(fourni)

« Sony’s Reader » apparait dans I'affichage par source
de eBook Library.

Un écran apparait sur le Reader, indiquant que
'appareil est raccordé a I'ordinateur.

Remarques

* Si « Sony’s Reader » n’apparait pas dans I'affichage par
source aprés le raccordement du Reader a 'ordinateur,
débranchez le cable USB du Reader, puis attendez quelques
instants avant de le reconnecter.

* Lorsque vous connectez le Reader a votre ordinateur,
lindication (connexion USB) s’affiche a I'écran du Reader.
Si la batterie est complétement épuisée, I'indication peut
mettre environ 40 minutes a s’afficher. Vous ne pourrez pas
mettre le Reader sous tension a 'aide du commutateur
POWER pendant ce temps. Dans ce cas, attendez que
lindication s’affiche. Un témoin rouge s’allume lors du
chargement du Reader si I'indication ne s’affiche pas a
I'écran.
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9 Cliquez sur « Library » dans I’affichage par source,
puis sur = (affichage par liste).

La zone d’affichage passe a 'affichage par liste et tout

le contenu de la Library est répertorié.

Conseils

* Lorsque vous cliquez sur « Books », « Audio » ou « Pictures »
dans l'affichage par source, seul le contenu correspondant
s’affiche.

* Lorsque vous cliquez sur # (affichage par vignette), le contenu
s’affiche sous forme de vignettes.

* Vous pouvez créer une collection dans la Library et celle-ci peut
étre transférée vers le Reader. Pour plus de détails sur la création
et le transfert d’'une collection, reportez-vous a I'’Aide eBook
Library.

O Sélectionnez le contenu que vous souhaitez
transférer depuis la liste.
Cliquez sur les fichiers tout en maintenant la touche Ctrl
enfoncée pour sélectionner plusieurs fichiers a la fois.

9 Faites glisser les fichiers depuis la liste vers
« Sony’s Reader » dans I’affichage par source.

Les fichiers sont transférés vers le Reader.

w

Reader de Sony
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Conseil

* Vous pouvez stocker des données informatiques dans la mémoire
flash intégrée de votre Reader en les transférant depuis votre
ordinateur a l'aide de I'Explorateur Windows.

Remarques

* Sila mémoire de votre Reader est insuffisante, les fichiers risquent
de ne pas pouvoir étre transférés. Transférez 'ensemble du
contenu inutile vers eBook Library, puis supprimez-le pour
augmenter I'espace disponible du Reader. (=] page 32)

* Ne supprimez pas le contenu des sous-dossiers ou les fichiers du
dossier « database » a I'aide de I’'Explorateur Windows. Gérez des
données a l'aide de eBook Library. Pour plus d’'informations sur
l'utilisation de eBook Library, reportez-vous a I'Aide eBook Library.

Transfert de contenu via une carte mémoire

Les fichiers importés dans eBook Library peuvent étre
transférés vers une carte mémoire insérée dans le Reader.
Conseil

* Vous pouvez utiliser les cartes « Memory Stick Duo » ou les
Cartes mémoire SD.

o Cliquez sur le menu Démarrer, puis sélectionnez
« Tous les programmes » — « Reader » —
« eBook Library » pour lancer eBook Library.

@ Raccordez votre Reader 2 votre ordinateur a Iaide
du cable USB fourni. (>] page 28)
« Sony’s Reader » apparait dans I'affichage par source
de eBook Library.
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9 Insérez une carte mémoire dans la fente pour carte
mémoire du Reader. (>] page 20)
« Memory Stick/SD Card on Sony’s Reader » apparait
dans I'affichage par source.

O Cliquez sur « Library » dans I’affichage par source,
puis sur = (affichage par liste).

La zone d’affichage passe a I'affichage par liste et tout
le contenu de la Library est répertorié.

Conseils

e Lorsque vous cliquez sur « Books », « Audio » ou « Pictures »
dans l'affichage par source, seul le contenu correspondant
s’affiche.

* Lorsque vous cliquez sur fiii (affichage par vignette), le contenu
s’affiche sous forme de vignettes.

* Vous pouvez créer une collection dans la Library et celle-ci peut
étre transférée vers la carte mémoire du Reader. Pour plus de
détails sur la création et le transfert d’'une collection, reportez-
vous a 'Aide eBook Library.

@ Sélectionnez le contenu que vous souhaitez
transférer depuis la liste.

Cliquez sur les fichiers tout en maintenant la touche Ctrl
enfoncée pour sélectionner plusieurs fichiers a la fois.

O Faites glisser les fichiers depuis la liste vers
« Memory Stick/SD Card on Sony’s Reader » dans
I’affichage par source.
Les fichiers sont transférés vers la carte mémoire du
Reader.
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Conseil

* Vous pouvez stocker des données informatiques dans la carte
mémoire insérée dans votre Reader en transférant ces données
depuis votre ordinateur a l'aide de I'Explorateur Windows.

Remarques

* Si la carte mémoire ne contient pas assez d’espace disponible, les
fichiers risquent de ne pas pouvoir étre transférés. Transférez tout
le contenu inutile vers eBook Library, puis supprimez-le pour
augmenter I'espace libre de la carte mémoire. (>] page 32)

* Ne supprimez pas le contenu des sous-dossiers ou les fichiers du
dossier « Sony Reader » a I'aide de I'Explorateur Windows. La
gestion des données s’effectue depuis eBook Library. Pour plus
d’'informations sur I'utilisation de eBook Library, reportez-vous a
I’Aide eBook Library.

Pour transférer du contenu de Pappareil vers
eBook Library

o Cliquez sur le menu Démarrer, puis sélectionnez
« Tous les programmes » — « Reader » — « eBook
Library » pour lancer eBook Library.

9 Raccordez votre Reader a votre ordinateur a l'aide
du cable USB fourni. (>] page 28)

« Sony’s Reader » apparait dans I'affichage par source.
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9 Cliquez sur « Sony’s Reader » dans I’affichage par
source, puis sur = (affichage par liste).

La zone d’affichage passe a 'affichage par liste et tout
le contenu de la Library est répertorié.

Conseils

¢ Lorsque vous cliquez sur « Books », « Audio » ou « Pictures »
dans l'affichage par source, seul le contenu correspondant
s’affiche.

* Lorsque vous cliquez sur # (affichage par vignette), le contenu
s’affiche sous forme de vignettes.

* Vous pouvez créer une collection dans le Reader ou sur une
carte mémoire du Reader, puis cette collection peut étre
transférée vers eBook Library. Pour plus de détails sur la création
et le transfert d’'une collection, reportez-vous a I'Aide eBook
Library.

O Sélectionnez le contenu que vous souhaitez
transférer depuis la liste.
Pour sélectionner plusieurs fichiers a la fois, cliquez tout
en maintenant la touche Ctrl enfoncée.

O Faites glisser les fichiers depuis la liste vers
« Library » dans I’affichage par source.

Le contenu de I'appareil est transféré vers eBook
Library.

33 FR



Synchronisation du contenu de la Library
avec le Reader

Vous pouvez synchroniser le contenu de votre eBook Library
avec le Reader en sélectionnant un dossier (tel que

« Library » ou ses sous-dossiers). Le Reader peut étre mis a
jour automatiquement pour correspondre au contenu de la
Library, lors du raccordement a votre ordinateur.

Remarque

* Pour synchroniser le contenu de votre eBook Library avec le
Reader, vous devez spécifier un dossier (tel que
« Library » ou ses sous-dossiers). Pour plus de détails sur la
sélection d’'un dossier, reportez-vous a I'’Aide eBook Library.

Conseil

e Si vous souhaitez synchroniser instantanément le contenu de la
Library avec le Reader, vous pouvez aussi les synchroniser
manuellement. Pour plus de détails sur la synchronisation manuelle
du contenu, reportez-vous a I’Aide eBook Library.

(1) Cliquez sur le menu Démarrer, puis sélectionnez
« Tous les programmes » — « Reader » — « eBook
Library » pour lancer eBook Library.

e Raccordez le Reader a votre ordinateur a I'aide du
cable USB fourni. (>] page 28)

eBook Library commence automatiquement la synchronisation
du contenu de la Library avec le Reader.

Conseil
* Sivous démarrez eBook Library aprés avoir raccordé le Reader a votre
ordinateur, eBook Library commence aussi automatiquement la
synchronisation du contenu de la Library avec le Reader.
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Lecture/Ecoute/Visualisation d’un contenu

Lecture de livres

Lecture de livres transférés depuis votre

ordinateur

Suivez les étapes ci-dessous pour lire des livres transférés
depuis votre ordinateur.

o Dans le menu d’accueil, appuyez sur la touche A/VY
pour sélectionner « Books by Title », puis appuyez
sur Entrée.

La liste de livres apparait.

Si le contenu du livre sur le Reader et la carte mémoire
dépasse 30 éléments, le menu d’index apparait. Vous
pouvez trier davantage la liste de livres en sélectionnant
un élément de catégorie dans le menu d’index.

(=] page 43)

Indique que le
Crem— C0Ment est
enregistré sur la

Continue Reading e nates J " :

[ Books by Title . 4; A Christmas Carol 2 Carte m e m 0| re .

& Books by Author |3 Dream Psychology . § @ i Memory

Books by Date L Emma 4 StICk D uo »
Collections 5 » Les Miserables 5 .

EAII Bookmarks e g Metamorphosis E " Ca,rte .

IIWM ; MobyDick,or,thevy o ; memOIre SD

J3 Audio 1 ; A Study in Scarlef ; L, L,

9 Pitures o g TheTmeMachine |l BOULONS NUMErotés

=1 Settings 0| Ulysses 0

7 oo
o ¢ 10f1 [ 2013

o)
i
2
82
@
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Conseils

* Le contenu de la carte mémoire apparait également dans la liste
de livres.

e QOutre les touches A/V, vous pouvez également sélectionner un
élément en appuyant sur la touche numérique correspondant au
bouton numéroté.

* Pour afficher le reste de la liste, appuyez sur > (de fagcon répétée).

* Vous pouvez passer directement & la derniére page affichée en
sélectionnant « Continue Reading » dans le menu d’accueil, sans
afficher la liste de livres.

* Si une opération incorrecte est effectuée, €l apparait au bas de
I'écran.

Appuyez sur A/V pour sélectionner le livre de votre
choix dans la liste, puis appuyez sur Entrée.

Le menu d’options apparait. (=] page 37)

Appuyez sur A/VY pour sélectionner la facon d’ouvrir
le livre, puis appuyez sur Entrée.
Pour lire le livre depuis le début, appuyez sur A/Y pour

sélectionner « Begin », puis appuyez sur Entrée.
La premiere page du livre apparait.

Pour ouvrir la table des matiéres du livre ou les signets
du fichier PDF, appuyez sur A/¥ pour sélectionner

« Table of Contents », puis appuyez sur Entrée.

La table des matieres ou les signets apparaissent (le
cas échéant).

Appuyez sur MENU pour fermer le livre.
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A propos du menu d’options
f_ Le titre du livre est affiché.

- , - L
Pour ouvrir la derniére page affichée.
€2 Begin —=— Pour ouvrir la premiére page du livre.
3 End ] L . Y .
MBookmarks Pour ouvrir la derniere page du livre.
R ,_;t Pour ouvrir la liste des signets. (=] page 47)
@ to "~ Pour ouvrir la table des matiéres du
 tites Ll livre ou les signets du fichier PDF, le
cas échéant.
E T T—

Pour ouvrir la liste des pages
précédemment affichées (=] page 50)

— Pour afficher les informations relatives au livre. (>] page 42)

— Pour supprimer tous les signets ou effacer
Ihistorique. (] pages 49, 50)

Types de livre pris en charge par le Reader
Les types de livres pris en charge par le Reader et leurs
caractéristiques sont décrits ci-dessous.

eBook Livre au format BBeB qui peut étre
(extension de téléchargé depuis CONNECT eBooks.
fichier .Irf et .Irx) | Loutil de liens intégré dans les eBooks
(sauts de page, etc.) peut étre utilisé.
(=] page 39)

Fichier PDF Fichier au format PDF (Version 1.4 ou
(extension de antérieure) Les signets et 'outil de liens
fichier .pdf) peuvent étre utilisés sur les fichiers PDF.

Fichier texte
(extension de
fichier .txt)
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Fichier RTF Fichier RTF automatiquement converti
(extension de depuis un fichier Microsoft Word.*
fichier .rtf) * Uniquement si Microsoft Word est installé
sur votre ordinateur.

Opérations possibles sur la page d’un livre
Vous pouvez exécuter les opérations suivantes a partir de
'écran de la page du livre.

Indicateur de taille
l — Numeéro de la page actuelle/
ommecmmmmms  \Ombre total de pages

Touche Opération
Touche > Permet de passer a la page suivante
(appuyez) ;

de sauter 10 pages a partir de la page actuelle
(maintenez la touche enfoncée).

Touche < Permet de passer a la page précédente
(appuyez) ; ) ,

de reculer de 10 pages a partir de la page
actuelle (maintenez la touche enfoncée).

Touches Permettent de passer a la page sélectionnée
numeériques | (appuyez) (=] page 40) ;

de passer a la derniere page (maintenez la touche
0 enfoncée) ; de passer a la premiere page
(maintenez la touche 1 enfoncée) ; de passer a
une page correspondant au(x) numéro(s) de la
touche (maintenez les touches 2-9 enfoncées).
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Touche

Opération

Touche

Q@ (taille)

Permet d’effectuer un zoom avant/arriere sur

une page.

A chaque pression sur la touche @ (taille), la

page est agrandie par incréments et revient a

sa taille d’origine une fois 'agrandissement

maximal atteint.

* Lors de la lecture d’'un eBook ou d’un fichier texte :
La taille change selon 3 incréments (€, @, @ -
indiquées au bas de 'écran).

e Lors de la lecture d'un fichier PDF :

La taille varie entre « Fit width » (la page remplit la
largeur de la fenétre) et « Fit Visible » (le texte et les
graphiques remplissent la largeur de la fenétre).

e En maintenant la touche @ (taille) enfoncée pendant
quelques secondes, vous pouvez modifier lorientation
de 'écran (verticale/horizontale). (=] page 41)

Touche
(MARQUE)

Permet de créer ou supprimer un signet sur la
page actuelle (appuyez) (=] pages 47, 49) ;

de passer a I'écran All Bookmark (maintenez la
touche enfoncée).

Touche MENU

Permet de fermer la page et de revenir au menu d’options.

Pour utiliser Poutil de liens des eBooks/fichiers

PDF sur le

Reader

Lorsqu’un eBook ou un fichier PDF est affiché, vous pouvez
utiliser l'outil de liens intégré.

Le lien est mis en surbrillance a I'écran. Appuyez sur Entrée
pour ouvrir le contenu du lien ou passer a la page liée.

Lien
T Appuyez sur A/Y pour sélectionner le
lien de votre choix, puis appuyez sur
Chapter 3 - The Sccond nflhcv"l'vlucc Spirits </> pour revenir a |a page

— précédemment affichée.

39 FR



Acces direct a la page indiquée

Vous pouvez accéder directement a une page en saisissant
son numéro a l'aide des touches numériques.

o Dans I’écran de la page du livre, appuyez sur les
touches numériques pour sais